
 

Smt. Thorat Sushma S. et al                            www.ijetst.in Page 3341 
 

IJETST- Vol.||02||Issue||11||Pages 3341-3363||November||ISSN 2348-9480 2015 

         International Journal of Emerging Trends in Science and Technology 

DOI: http://dx.doi.org/10.18535/ijetst/v2i11.06 

Pushover Analysis of RCC Framed Structure 

 

Authors 

Smt. Thorat Sushma S.
1
, Prof. K. S. Upase

2
 

1
Student M.E. Structures, M.S.Bidve Engg, College, Latur-413512, 

Email: thoratsushma@rediffmail.com, Contact No. 09423524274 
2
M.E. Structures, Associate Professor, Department of Civil Engg., M.S. Bidve Engg. College, Latur-413512 

Email: ksu_upase@yahoo.co.in, Contact No.09422968873 

ABSTRACT 
From the effects of significant earthquakes (since the early 1980s) it is concluded that the seismic risks in urban areas are 

increasing and are far from socio-economically acceptable levels.  There is an urgent need to reverse this situation and it is 

believed that one of the most effective ways of doing this is through: (1) the development of more reliable seismic standards and 

code provisions than those currently available and (2) their stringent implementation for the complete engineering of new 

engineering facilities.  A performance-based design is aimed at controlling the structural damage based on precise estimations of 

proper response parameters. This is possible if more accurate analyses are carried out, including all potential important factors 

involved in the structural behavior. 

With an emphasis on providing stakeholders, owner the information needed to make rational business or safety-related decisions, 

design practice has moved toward predictive methods for assessing potential  seismic performance and has led to the 

development of performance based engineering methods  for seismic design.  

 

1. INTRODUCTION 

1.1 General 
Earthquakes are one of the greatest natural hazards which 

can make a uncountable damage to our earth. Earthquake is 

unpredictable hazard and we need a tool which can help us 

to come across with this hazard. Engineering can make a 

tool for the constructions which can sustain in these 

Earthquakes. Performance based design is gaining a new 

dimensions in the seismic design philosophy Where in the 

near field ground motion (usually acceleration) is to be 

considered. Earthquake loads are to be carefully modeled so 

as to be assess the real behavior of the structure with the 

clear understanding that damage is expected but it should be 

regulated. In this Project , pushover analysis which is 

iterative procedure shall be looked upon as an alternate for 

the orthodox analysis procedures.  This study focused on 

pushover analysis of multistoried R.C building subjected 

them to monotonically increasing lateral forces with an 

invariant height wise distribution until the preset 

performance level is reached. The promise of performance-

based seismic engineering (PBSE) is to produce structures 

with predictable seismic performance. Comprehensive 

effort by professionals from several disciplines is required 

to turn this promise into a reality. Earthquakes can create 

serious damage to structures & the damage to structures 

causes deaths, injuries, economic loss, and loss of functions. 

The structures already built are unprotected to future 

earthquakes. Earthquake risk is associated with seismic 

hazard, vulnerability of buildings, exposure. Seismic hazard 

quantifies the probable ground motion that can occur at site. 

Unpredictability of building is important is causing risk to 

life. India has witnessed Bhuj earthquake of Jan 26, 2001 

(fig 1.1). Sumatra earthquake of December 26, 2004, 

Kashmir earthquake of October 8, 2005, Nepal earthquakes 

in beside country & disasters due to earthquakes in the 

current decades. Most of the causalities were due to collapse 

of the buildings and or due to lack of rescue and relief to the 

victims under the collapsed buildings .Earthquakes do not 

kill people but poorly by unprotected designs of 

constructions. These earthquakes have clearly shown us that 

we need to have a comprehensive strategy for disaster 

managements which should include planning, design and 

construction of earthquake resistance buildings through 

strict compliance of Codal provisions for earthquake 

countermeasures. As of today, it is unfortunate that despite 

of having all  the scientific know-how in the field of 

earthquake engineering and the Codal provisions for 

construction in seismic areas, developed and brought out by 

the Bureau of Indian Standards, on account of ignorance or 

fear of added cost we continue to find utter neglect of our 

engineers and builders. Common people are not savvy to 

many aspects of earthquakes disaster and better building 

practices in seismic zones of the country. 

 

2. LITERATURE REVIEW  
Earthquake engineering is most sensible engineering field in 

the world. Performance based design approach is new 

concept and lot of research is going on the validating this 

approach. Number of scientist gone through this approach 

and explained the varieties of approaches it properties and 

limitations. Some of them are discussed below.   

Peter Fajfar et al (2000) 
[11]

 presented a relatively simple 

nonlinear method for the seismic analysis of structures (the 

N2 method). It combines the pushover analysis of a multi-
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degree-of-freedom (MDOF) model with the response 

spectrum analysis of an equivalent single-degree-of-

freedom (SDOF) system. The method is formulated in the 

acceleration- displacement format, which enables the visual 

interpretation of the procedure and of the relations between 

the basic quantities controlling the seismic response. 

Inelastic spectra, rather than elastic spectra with equivalent 

damping and period, were applied. This feature represents 

the major difference with respect to the capacity spectrum 

method. Moreover, demand quantities can be obtained 

without iteration. Generally, the results of the N2 method 

are reasonably accurate, provided that the structure 

oscillates predominantly in the first mode. In the work, the 

method is described and discussed, and its basic derivatives 

are given. The similarities and differences between the 

proposed method and the FEMA 273 and ATC 40 nonlinear 

static analysis procedures are discussed. Application of the 

method is illustrated by means of an example.  

J. B. Mander (2001)[10] reviewed from an historical 

perspective past and current developments in earthquake 

engineered structures. Based on the present state-of-the 

practice in New Zealand, and a world-view of the state-of-

the-art, he argued that in order to make progress towards the 

building of seismic resilient communities, research and 

development activities should focus on performance-based 

design which gives the engineer the ability to inform 

clients/owners of the expected degree of damage to enable a 

better management of seismic risk. To achieve expected 

performance outcomes it will be necessary to supplement, 

current force-based design standards with displacement-

based design methodologies.  

Improved design methodologies alone will not lead to a 

significantly superior level of seismic resilient communities, 

but rather lead to a superior standard of performance-based 

engineered structures where the post-earthquake outcome 

will be known with a certain degree of confidence. This 

paper gives two philosophical approaches that are referred 

to as Control and Repairability of Damage (CARD), and 

Damage Avoidance Design (DAD)  

Qiang Xue, et al (2003)[14] presented a performance-based 

seismic design procedure, which is directly associated with 

pre-quantified performance criteria, by employing a 

displacement-based approach. A lower bound of yielding 

displacement of the structure to satisfy these performance 

criteria was proposed. This approach is general and 

applicable for any type of reduced response spectrum that 

taking into account of the inelastic behavior provided the 

spectrum reduction factor regarding each spectral region is 

given. The procedure can be extended to fulfill multiple 

performance objectives and to consider special effects such 

as the near-fault and accumulative damage. In the presented 

design procedure of the building, the k factor plays an 

important role in controlling the design strength. The 

simplicity and applicability of the proposed procedure is 

demonstrated through numerical examples. The proposed 

design procedure, which starts from the pre-quantified 

performance objectives, is transparent and straightforward 

to present the underlying concept of ―performance based 

design‖. Non-linear time history analysis verified that this 

approach is applicable to control the target displacement to 

the performance acceptable limit. Its flexibility in 

considering special effect such as near-fault or strong 

motion duration and simplicity in a proposed multiple 

performance objectives design are demonstrated.  

Andreas J. Kappos et al (2004)
[1]

 proposed a performance-

based design procedure for realistic 3D reinforced concrete 

(R/C) buildings, which involves the use of advanced 

analytical tools. The proposed method was then applied to a 

regular multistory reinforced concrete 3D frame building 

and was found to lead to better seismic performance than 

the standard code (Euro code 8) procedure, and in addition 

led to a more economic design of transverse reinforcement 

in the members that develop very little inelastic behavior 

even for very strong earthquakes.  

The building was first designed to a standard code 

procedure, and then redesigned to the proposed method. 

Due to its high regularity, the building was designed using 

both versions of the method (based on either inelastic 

dynamic or inelastic static analysis). In addition, several 

alternative designs to the new method were carried out. All 

designs were subsequently assessed for a number of 

performance objectives, using both local and global criteria.  

A six-storey R/C, doubly symmetric structure (three 3 m 

spans in y-direction, three spans of 6,4,6 m in x-direction) 

was selected as a test of the proposed procedure. The 

building was first designed to the provisions of the current 

Greek Seismic Code, which is very similar to Euro code 8 

(CEN, 1995) [9] ductility class M‖ (medium), for a design 

ground acceleration of 0.25g, assuming class A soil 

conditions (stiff deposits). Earthquake loading was 

combined with gravity loading G + 0.3 LL. The materials 

used in the structure are C20/25 (characteristic cylinder 

strength of 20 MPa) concrete, and S400 steel (characteristic 

yield strength of 400 MPa). Square column crosssections 

(from 300 to 450 mm) were used, with reinforcement ratios 

not exceeding about 2% (the minimum reinforcement ratio 

for columns was 1%). Beam sections varied from 200×400 

to 300×650 (mm
2
).  

 
Figure 2.1 - Required amount of steel in beams and 

columns for all designs  

 

Both elastic and inelastic (dynamic and static) analyses of 

the structure were carried out using SAP 2000 Nonlinear‖ 

(Computers and Structures, 2000), adopting a member-by-

member modeling approach. Inelastic beam (and column) 

members were modeled as elastic elements with inelastic 

springs (plastic hinges) at their ends; the effective rigidity of 

T-beams was taken equal to 40% the gross section rigidity 

(EIg), while for columns 80% of EIg was assumed. The 

moment curvature characteristics of the plastic hinges were 

estimated from section analysis using appropriate non-linear 
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constitutive laws for concrete and steel (Penelis and 

Kappos, 1997) 
[27]

; member strength and ductility were 

estimated on the basis of the nonlinear section analysis 

results.  

Vipul Prakash (2004) 
[9]

 gives the prospects for 

Performance Based Engineering (PBE) in India. He lists the 

pre-requisites that made the emergence of PBE possible in 

California, compares the situation in India and discusses the 

tasks and difficulties for implementing PBE in India.  

In India, the criteria for earthquake resistant design of 

structures are given in IS 1893, published by the Bureau of 

Indian Standards (BIS). IS 1893-2002 reduced the number 

of seismic zones to four by merging zone I with zone II and 

adopted a modified CIS64 scale for seismic zoning and 

dropped references to the MMI scale. The mapping of zones 

to intensities in IS 1893-2002 is given in Table 2.1.  

 

Table 2.1 - Mapping Seismic Zones to Intensities in IS 

1893-2002  

In IS 189320 02 

Seismic Zone  Mapped to a Modified CIS- 

II  VI and below 

III  VII 

IV  VIII 

V  IX and above 

In US, building performance levels are divided into 

structural performance levels (SP-1 to SP6) and 

nonstructural performance levels (NP-A to NP-E), and then 

a combination of structural and nonstructural performance 

levels is set as the performance objective to be met at a 

given level of earthquake. These combinations can be 

approximately mapped to the damage grades specified in 

EMS-98 as follows:  

IS 1893- 2002 specifies two levels of earthquakes – 

Maximum Considered Earthquake (MCE) and Design Basis 

Earthquake (DBE). In Clause 6.1.3, it states the 

performance objective as follows: ―The design approach 

adopted in this standard is to ensure that structures possess 

at least a minimum strength to withstand minor earthquakes 

(< DBE), which occur frequently, without damage; resist 

moderate earthquake (DBE) without significant structural 

damage though some nonstructural damage may occur; and 

aims that structures withstand a major earthquake (MCE) 

without collapse. 

 

 

 

 

 

 

 

 

 

 

Table 2.2 Comparison of Damage Grades as per EMS-98 and Building Performance Levels 

Damage Grade as per EMS-98  Approximate Building Performance Combination in PBE  

Grade 1  

(no structural damage, slight nonstructural damage)  

SP-1 (immediate occupancy)  

+ NP-A (operational)  

= 1-A (operational)  

Grade 2  

(slight structural damage, moderate nonstructural  

damage)  

SP-1 (immediate occupancy)  

+ NP-B (immediate occupancy)  

= 1-B (immediate occupancy)  

Grade 3  

(moderate structural damage, heavy  on structural damage)  

SP-3 (life safety) + NP-C (life safety)  

= 3-C (life safety)  

Grade 4  

(heavy structural damage, very heavy nonstructural  damage)  

SP-5 (structural stability) +  

NP-E (not considered)  

= 5-E (structural stability)  

Grade 5  

(very heavy structural damage)  

SP-6 (not considered) + NP-E (not considered)  

= 6-E (not considered)  

 

In PBE, merely stating a performance objective is not 

sufficient; it has to be followed up by analyses or a 

methodology for ensuring that the stated performance 

objectives will indeed be met by the evaluated structures. 

PBE thus requires much tighter language and cross-

referencing to be used in the specifications.  

X.-K. Zou et al (2005)[19] present an effective computer-

based technique that incorporates pushover analysis 

together with numerical optimization procedures to 

automate the pushover drift performance design of 

reinforced concrete (RC) buildings. Performance-based 

design using nonlinear pushover analysis, is a highly 

iterative process needed to meet designer-specified and code 

requirements. This paper presents an effective computer-

based technique that incorporates pushover analysis 

together with numerical optimization procedures to 

automate the pushover drift performance design. Steel 

reinforcement, as compared with concrete materials, 

appears to be the more cost-effective material that can be 

effectively used to control drift beyond the occurrence of 

first yielding and to provide the required ductility of RC 

building frameworks.  

In this study, steel reinforcement ratios are taken as design 

variables during the design optimization process. Using the 

principle of virtual work, the nonlinear inelastic seismic 

drift responses generated by the pushover analysis can be 
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explicitly expressed in terms of element design variables. 

An optimality criteria technique is presented in this paper 

for solving the explicit performance-based seismic design 

optimization problem for RC buildings. Two building frame 

examples are presented to illustrate the effectiveness and 

practicality of the proposed optimal design method.  

The design optimization procedure for limiting 

performance-based seismic drifts of an RC building 

structure is listed as follows:  

1. Establish an initial design with optimal member 

dimensions, which can be obtained from the elastic 

seismic design optimization by minimizing the 

concrete cost of an RC structure subjected to a 

minor earthquake loading using the elastic 

response spectrum analysis method.  

2. Determine the design spectra, corresponding to 

different earthquake demand levels, which will be 

used in the nonlinear pushover analysis.  

3. Conduct a static virtual load analysis to obtain the 

member internal forces that will be used in 

formulating inelastic drift responses by employing 

the principle of virtual work.  

4. On the basis of the optimal member size, determine 

the minimum and maximum size bounds of the 

steel reinforcement ratios, pi and pi’, in accordance 

with the strength-based code requirements.  

R. K . Goel and A. K. Chopra(2006)
[5] 

presented an 

improved Direct Displacemnt Based Design Procedure for 

Performance-Based seismic design of structures. Direct 

displacement-based design requires a simplified procedure 

to estimate the seismic deformation of an inelastic SDF 

system, representing the first (elastic) mode of vibration of 

the structure. This step is usually accomplished by analysis 

of an ―equivalent‖ linear system using elastic design 

spectra. In their work, an equally simple procedure is 

developed that is based on the well-known concepts of 

inelastic design spectra. This procedure provides: (1) 

accurate values of displacement and ductility demands, and 

(2) a structural design that satisfies the design criteria for 

allowable plastic rotation. In contrast, the existing procedure 

using elastic design spectra for equivalent linear systems is 

shown to underestimate significantly the displacement and 

ductility demands.  

In this work, it is demonstrated that the deformation and 

ductility factor that are estimated in designing the structure 

by this procedure are much smaller than the deformation 

and ductility demands determined by nonlinear analysis of 

the system using inelastic design spectra. Furthermore, it 

has been shown that the plastic rotation demand on 

structures designed by this procedure may exceed the 

acceptable value of the plastic rotation.  

Qiang Xue, Chia-Wei Wu et al (2007)[15] summarized the 

development of the seismic design draft code for buildings 

in Taiwan using performance-based seismic design 

methodology and case studied following the guidelines in 

the paper. They presented the design of a reinforced 

concrete building by using the draft code.  

In their study first, the current seismic design code 

provisions are examined according to the theoretical basis 

of PBSD to identify which methodologies of PBSD need to 

be incorporated into the current seismic design code. Then, 

a PBSD flowchart is presented. Finally, a draft of the 

proposed code is described. Transparent seismic design 

objectives for buildings of different use groups have been 

established qualitatively and interpreted quantitatively as 

performance criteria including drift limits. Site feasibility 

requirements, conceptual design scopes and basic rules have 

been proposed. Performance objective-oriented procedures 

for preliminary design and seismic performance evaluation 

have been presented. Suggestions on seismic performance 

criteria and the evaluation of existing buildings have been 

made. In order to provide clear, easy to follow guidelines, 

comparisons and case studies have also been conducted.  

The performance-based seismic design code introduces a 

transparent platform in which the owners and designers can 

exchange their views on the expected seismic performance 

of the buildings under different levels of earthquakes. For 

buildings of different seismic use groups, specific 

performance goals are established without employing an 

importance factor. Performance levels are quantified 

through parameters associated with structural strength, 

stiffness and ductility. Conceptual design rules with focuses 

on redundancy and uniform continuity of strength, stiffness 

and ductility are specified. A performance objective-

oriented preliminary design procedure is presented with 

consideration of flexibility. Preliminary checks on the 

interstory drift limit may help in finding the stiffness 

deficiencies earlier in the preliminary design stage and save 

some computational effort, particularly for steel structures.  

The differences between seismic performance assessments 

of new buildings and those of existing buildings are pointed 

out. In engineering practice, member size standards and 

construction convenience are usually considered. A 

structure designed in this way usually has a lower ductility 

capacity than that specified in the code because structural 

ductility is not uniformly distributed. However, the 

structural strength and stiffness are usually higher than the 

demand. Therefore, the prescribed performance objective is 

usually satisfied.  

According to the case study, if the same column size has 

been adopted for the first several floors, a higher 

reinforcement ratio assigned to the first 2 stories is helpful 

for uniform distribution of system ductility. Adopting the 

performance criteria in the draft code, direct displacement-

based design procedures have been applied successfully for 

moment resisting frames without iteration. The performance 

criteria associated with stiffness or displacement as 

suggested in the draft code should not be used either as 

optimized design criteria or in a direct displacement-based 

design procedure for structural systems other than moment 

resisting frames.  

In this draft code, the design of nonstructural components is 

done to accommodate either acceleration or displacement. 

No specific criterion regarding economic loss is provided. 

The nonstructural damage is limited by the structural drift 

limit.  
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Figure 2.2 - Performance Objectives  

 

As shown in Fig. 2.2, three seismic hazard levels were 

considered and can be distinguished by return period, 

probability of exceedance, or corresponding site intensity 

scale. Performance of a building has been classified into 5 

levels, Operational (OP), Immediate Occupancy (IO), 

Damage Control (DC), Life Safety (LS) and Collapse 

Prevention (CP).  

Whittaker, Y. N. Huang et al (2007) 
[18] 

summarize the 

next (second) generation tools and procedures for 

performance-based earthquake engineering in the United 

States. The methodology, which is described in detail in the 

draft Guidelines for the Seismic Performance Assessment of 

Buildings, builds on the first generation deterministic 

procedures, which were developed in the ATC-33 project in 

the mid 1990s and in ASCE Standard: ASCE/SEI 41-06 

Seismic  

Nilesh M. Kashid (2011)
[12]

 Says that, During the last few 

decades, earthquake engineering has undergone significant 

development. Initially, structures were designed without 

considering seismic loading. Later, it was observed that the 

structures designed for some lateral loads like wind etc. 

performed significantly well than those designed for gravity 

loading only. Hence, the importance of considering 

earthquake forces in the design process is realized and 

seismic resistant design became a practice. Further with the 

advent of time history analysis and better understanding of 

seismic response. The importance of ductility of structure is 

realized in resisting even higher seismic loads than the 

designed loads. The design base shear force is reduced by 

introducing a response reduction factor to consider an 

inelastic displacement capacity of ductile structure in 

dissipating the energy. Further, with more understanding of 

structural behaviour at micro-level or element level, the 

concept of “capacity design” was introduced and this forced 

to decide the required performance of the structure right at 

the design stage itself. Today, the seismic design codes of 

various countries are being revised to decide performance 

criteria of the buildings that will suit the existing design and 

construction practices in the respective countries. In this 

paper, an attempt has been made to develop a possible 

method of seismic analysis that can be incorporated in the 

existing Indian Seismic Code I.S.: 1893- 2002. For the 

purpose, some of the key features the existing methodology 

followed by Federal Emergency Management Agency 

(FEMA) of United States of America is made use of.  

Sudhanshu Sood (2011) 
[16]

 mentioned his paper that, A 

performance-based design is aimed at controlling the 

structural damage based on precise estimations of proper 

response parameters. Performance-based seismic design 

explicitly evaluates how a building is likely to perform; 

given the potential hazard it is likely to experience, 

considering uncertainties inherent in the quantification of 

potential hazard and uncertainties in assessment of the 

actual building response. It is an iterative process that 

begins with the selection of performance objectives, 

followed by the development of a preliminary design, an 

assessment  as to whether or not the design meets the 

performance objectives, and finally redesign 

and  reassessment, if required, until the desired performance 

level is achieved.  In this present study two R.C buildings, 

one symmetrical and one unsymmetrical in plan (designed 

according to IS 456:2000) are analysed using Pushover 

Analysis and redesigning by changing the main 

reinforcement of various frame elements and again 

analyzing. The pushover analysis has been carried out using 

SAP2000, a product of Computers and Structures 

International. A total of 24 cases for a particular four storey 

building located in ZoneIV have been analyzed, changing 

reinforcement of different structural elements,  

 

3. METHODOLOGY 

3.1 Introduction  

Force Based design is a traditional approach to Seismic 

Design of a Building. Using the Response Spectrum the 

design lateral forces on the Building are determined & the 

members are designed to withstand these forces. In this 

approach, there is no measure of the deformation capability 

of a member or of the building. At best, an elastic drift is 

computed under the design forces and checked against an 

elastic drift limit. Alternatively, an inelastic drift is 

estimated from the calculated elastic drift by multiplying the 

later by a factor and checking the inelastic drift against an 

inelastic drift limit.  

In performance based analysis the deformations of the 

members and the building as a whole are quantified under 

the lateral forces of an earthquake of a certain level of 

seismic hazard. The deformations or strains are better 

quantities to assess damage than stresses or forces. A 

performance based analysis requires a nonlinear lateral load 

versus deformation curve as the deformations are expected 

to go beyond the elastic curve. The performance based 

analysis gives the analyst more choices of 

“PERFORMANCE" of the building as compared to the 

limit states of collapse and serviceability in a design based 

on limit state method.  

3.2 Performance-Based Seismic Design Process  
Performance-based design is an iterative process that begins 

with the selection of performance objectives, followed by 

the development of a preliminary design, an assessment as 

to whether or not the design meets the performance 

objectives, and  finally redesign and reassessment, if 

required, until the desired performance level is achieved.  

3.3  Select Performance Objectives  
The process begins with the selection of design criteria 

stated in the form of one or more performance objectives. 

Performance objectives are statements of the acceptable risk 

of incurring different levels of damage and the 

consequential losses that occur as a result of this damage, at 

a specified level of seismic hazard. Since losses can be 

associated with structural damage, nonstructural damage, or 
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both, performance objectives must be expressed considering 

the potential performance of  

3.3.1 Performance Levels  

Building performance is a combination of the performance 

of the structure, the nonstructural elements and systems and 

the contents. Although structural and non – structural 

performance may be affected by similar seismic response 

parameters, it may be convenient to consider the two 

separately. This approach allows for selection of different 

performance levels for structural and non-structural 

systems. A common practice in seismic 

rehabilitation  might be to select life safety performance 

level for the structural system and a hazard mitigated 

approach involving anchoring heavy items for the non 

structural components [FEMA 273:1997]. Although 

different performance levels may be selected for structural 

and non-structural systems, in general the approach to 

evaluating acceptability is nonetheless the same.  

The decision to include or exclude performance of the 

building contents may be influenced by the significance of 

the hazard passed by the contents or whether the structural 

engineer has control over how contents are introduced and 

used in a building. Except for specialized facilities or 

contents, the structural engineer’s responsibility normally 

does not include contents.  

A wide range of performance can be targeted in building 

design, ranging from damage onset to collapse. Performance 

terminology usually is selected so that owners, risk 

managers, or users without a structural engineering 

background can readily understand it. As a result, the 

terminology itself may be somewhat ambiguous in 

engineering terms. Unambiguous definition of the 

performance levels or states must accompany the 

terminology.  

A series of performance definition has been selected for this 

document. The series ranges from what is being defined as 

damage onset through collapse. These performance levels 

are presently roughly in order of increasing damage and 

decreasing function, as illustrated in figure 3.2. The 

performance levels are shown in the ranges likely for most 

buildings. Precisely where the performance level falls for a 

specific building will depend on the building configuration, 

material and details. Precise definition, rather than ranges, 

will be needed in the code implementation.  

3.3.2 Building Performance Levels  

3.3.2.1  Operational Level   

This Building Performance Level is a combination of the 

Structural Immediate Occupancy Level and the 

Nonstructural Operational Level. Buildings meeting this 

performance level are expected to sustain minimal or no 

damage to their structural and nonstructural components. 

The building is suitable for its normal occupancy and use, 

although possibly in a slightly impaired mode, with power, 

water, and other   

Figure 3.2: Capacity Curve  

required utilities provided from emergency sources, and 

possibly with some nonessential systems not functioning. 

Buildings meeting this performance level pose an extremely 

low risk to life safety. Under very low levels of earthquake 

ground motion, most buildings should be able to meet or 

exceed this performance level. Typically, however, it will 

not be economically practical to design for this performance 

under severe levels of ground shaking, except for buildings 

that house essential services.  

3.3.2.2 Immediate Occupancy Level   

This Building Performance Level is a combination of the 

Structural and Nonstructural Immediate Occupancy levels. 

Buildings meeting this performance level are expected to 

sustain minimal or no damage to their structural elements 

and only minor damage to their nonstructural components. 

While it would be safe to reoccupy a building meeting this 

performance level immediately following a major 

earthquake, nonstructural systems may not function due to 

either a lack of electrical power or internal damage to 

equipment. Therefore, although immediate reoccupancy of 

the building is possible, it may be necessary to perform 

some cleanup and repair, and await the restoration of utility 

service, before the building could function in a normal 

mode. The risk to life safety at this performance level is 

very low. Many building owners may wish to achieve this 

level of performance when the building is subjected to 

moderate levels of earthquake ground motion. In addition, 

some owners may desire such performance for very 

important buildings, under severe levels of earthquake 

ground shaking. This level provides most of the protection 

obtained under the Operational Level, without the cost of 

providing standby utilities and performing rigorous seismic 

qualification of equipment performance.  

3.3.2.3 Life Safety Level   

This Building Performance Level is a combination of the 

Structural and Nonstructural Life Safety levels. Buildings 

meeting this level may experience extensive damage to 

structural and nonstructural components. Repairs may be 

required before reoccupancy of the building occurs, and 

repair may be deemed economically impractical. The risk to 

life in buildings meeting this performance level is low. 

Many building owners will desire to meet this performance 

level for a severe level of ground shaking. 
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Table 3.1 - Details of Performance level  

Performance 

Level  
Structural Performance  Non Structural Performance  

Operational (O)  

1. Very light damage  

2. No permanent drift  

3. Substantially original strength and stiffness  

1. Negligible damage.  

2. Power & other utilities are available.  

Immediate  

Occupancy (IO)  

1. Light damage  

2. No permanent drift  

3. Substantially original strength & stiffness 

Minor cracking 

4. Elevators can be restarted  

5. Fire protection operable  

1. Equipments & content secure but may not operate 

due to mechanical/utility failure.  

Life Safety (LS)  

1. Moderate damage 

2. Some permanent drift Residual strength & 

stiffness in all stories  

3. Gravity elements function  

4. Building may be beyond economical repair  

1. Falling hazard mitigated but extensive systems 

damage.  

Collapse 

Prevention  

(CP)  

1. Severe damage  

2. Large permanent drifts 

3. Little residual strength & stiffness  

4. Gravity  elements function Some exits 

blocked  

5. Building near collapse  

1. Extensive damage.  

 

3.3.2.4  Collapse Prevention Level   

This Building Performance Level consists of the 

Structural Collapse Prevention Level with no 

consideration of nonstructural vulnerabilities. Buildings 

meeting this performance level may pose a significant 

hazard to life safety resulting from failure of nonstructural 

components. However, because the building itself does 

not collapse, gross loss of life should be avoided. Many 

buildings meeting this level will be complete economic 

losses.  

3.4 Seismic Hazard   

For any type of solution details estimation of problem is 

assessed , so before design the seismic hazard is assessed . 

The most important seismic hazard to the majority of the 

building is earthquake ground shaking. The hazard posed by 

shaking includes both the motions imparted to the isolated 

structure as well as the hazard from adjacent building due to 

pounding, shared elements, or falling debris. Other hazard 

that may be considered in special cases include ground 

failure (liquefaction and lateral spreading, land sliding, 

differential settlement, or surface fault rupture); loading, 

flooding, or other water damage due tsunami; or collateral 

hazard such as fire or hazardous chemical release. These 

mentioned hazard are not usually of direct interest in 

displacement based design, although in special cases the 

effects of ground movement will be considered.  

3.4.1 Seismic hazard levels:  

Seismic hazard level should be selected considering the 

building function, its targeted performance, and its expected 

service life. Seismic hazard level can be stated in terms of 

probability that those levels will be exceeded over an 

established time. A common reference time is 50 years, 

which relates conveniently to both the service of a 

conventional building structure as well as the adult life of a 

typical occupant or investor, and hence relates both to 

property risk and life risk.  

Some performance objectives aimed at providing enhanced 

performance such as continued occupancy will consider a 

seismic hazard defined, for example by 10% reliability of 

design for life safety has considered a 10% probability of 

exceedance level in 50 years, or a return period of 

approximately 475 years.  

Four levels of earthquake hazard are defined for the 

performance objectives. EQ-I represents a frequent event 

and is defined as the earthquake that has an 87% probability 

of being exceeded in a 50 year period (annual probability of 

exceedance of 4% or mean recurrence interval of 

approximately 25 years). EQ-II has a mean recurrence 

interval of 72 years, EQ-III has a recurrence interval 

between 250 and 800 years, and EQ-IV has a recurrence 

interval between 800 and 2500 years.  

3.4.2 Combined Performance level and Seismic Hazard 

Level   

Three standard performance objectives are defined as shown 

in Figure 3.3. Basic Safety Objective (BSO) is 

recommended for PBSE of standard occupancy structures 

and requires level 1 performance in EQ-I, level 2 

performances in EQ-II, level 3 performance in EQ-III and 

level 4 performance in EQ-IV. Enhanced Objective 1 (EQI) 

is a higher objective than BSO and requires level 1 

performance in EQ-II, level 2 performance in Reproduced 

with permission of the copyright owner. Further 

reproduction prohibited without permission. EQ-III and 

level 3 performance in EQ-IV. E02 is considered for safety 

critical facilities and includes level 1 performance in the 

EQ-I, EQ-II and EQ-III and level 2 performance for EQ-IV. 
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As seen from Figure (1.1) a performance objective is a 

combination of a hazard level and the expected performance 

under that hazard. The hazard level is determined by a 

probabilistic hazard analysis (PSHA) and expressed in terms 

of the annual frequency of exceedance or return period. The 

SEAOC Blue Book and SEAOC Vision 2000 report (1995) 

define the performance levels in both qualitative and 

quantitative terms. The quantitative levels are defined 

through limiting values of measurable response parameters, 

such as story drifts and ductility demands. The DBD 

method presented here uses hazard estimates represented by 

Uniform Hazard Spectra given by codes, for example 

NBCC 2005, and quantitative displacement, drift and 

ductility measures to satisfy the desired performance 

objectives.  

3.5 Push Over Analysis  

Pushover Analysis is a nonlinear, static procedure in which 

the lateral loads' magnitude is incrementally increased, 

maintaining a predefined distribution pattern along the 

height of the building. Weak links and failure modes of the 

buildings are found with the help of the increase in the 

magnitude of the loads.  

 
Figure 3.3 - Standard Performance Objectives (SEAOC 

Blue Book) 

 

In Pushover analysis, a static horizontal force profile, 

usually proportional to the design force profiles specified 

in the codes, is applied to the structure. The force profile is 

then incremented in small steps and the structure is 

analyzed at each step. As the loads are increased, the 

building undergoes yielding at a few locations. Every time 

such yielding takes place, the structural properties are 

modified approximately to reflect the yielding. The 

analysis is continued till the structure collapses, or the 

building reaches certain level of lateral displacement.  

 

3.6 Need For Pushover Analysis  
Conventionally, seismic assessment and design has relied on 

linear or equivalent linear (with reduced stiffness) analysis 

of structural systems. In this approach, simple models are 

used for various components of the structure, which is 

subjected to seismic forces evaluated from elastic or design 

spectra, and reduced by force reduction (or behavior) 

factors. The ensuing displacements are amplified to account 

for the reduction of applied forces. This procedure, though 

simple and easy to apply in the design office environment, 

suffers from the following shortcomings:  

1. The force reduction factors recommended in codes 

of practice are approximate and do not necessarily 

represent the specific structure under consideration.  

2. When critical zones of a structure enter into the 

inelastic range, the force and deformation 

distribution change significantly. This change is 

not represented by a global reduction of forces.  

3. The mechanism that will most likely perpetuate 

collapse is unlikely to be that represented by the 

elastic action and deformation distribution.  

4. The global and particularly the local distribution of 

deformations in the inelastic range may bear no 

resemblance to those in the elastic range. The same 

applies to the values of deformations, not just the 

distribution.As a consequence of the above, the 

reduced forces - amplified deformations linear 

elastic approach fails to fit within the principle of 

failure mode control, which is part of performance 

based assessment and design. This in turn has lead 

to an increase in the use of inelastic analysis as a 

more realistic means of assessing the deformational 

state in structures subjected to strong ground 

motion.  

The pushover analysis is a significant step forward by 

giving consideration to those inelastic response 

characteristics that will distinguish between good and bad 

performance in severe earthquakes. The non-linear static 

pushover analysis is a partial and relatively simple 

intermediate solution to the complex problem of predicting 

force and deformation demands imposed on a structure and 

its elements due to ground motion.  

Here, the important terms are static and analysis. Static 

implies that a static method is being employed to represent a 

dynamic phenomenon; a representation that is adequate in 

many cases but doomed to failure in some cases. Analysis 

implies that a system solution has been created already and 

the pushover is employed to evaluate the solution and 

modify it as needed.  

The pushover is a part of an evaluation process and provides 

estimates of demands imposed on structures and elements. 

Hence, there is always a need of a method which is more 

rational and accurate and at the same time able to identify 

seismic deficiencies correctly and that too in correct order 

of vulnerability. Pushover analysis is able to satisfy these 

criteria satisfactorily and in a convenient way.  

3.7 Description Of Pushover Analysis  

The non-linear static pushover procedure was originally 

formulated and suggested by two agencies namely, federal 

emergency management agency (FEMA) and applied 

technical council (ATC), under their seismic rehabilitation 

programs and guidelines. This is included in the 

documents FEMA-273, FEMA-356 and ATC40.3.4.2.1 

Introduction to FEMA-273. The primary purpose of 

FEMA-273 document is to provide technically sound and 

nationally acceptable guidelines for the seismic 

rehabilitation of buildings. The Guidelines for the Seismic 

Rehabilitation of Buildings are intended to serve as a ready 

tool for design professionals for carrying out the design 

and analysis of buildings, a reference document for 

building regulatory officials, and a foundation for the 

future development and implementation of building code 

provisions and standards.  

3.8 Capacity Spectrum Method   

One of the methods used to determine the performance 

point is the Capacity Spectrum Method, also known as the 
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Acceleration-Displacement Response Spectra method 

(ADRS). The Capacity Spectrum method requires that both 

the capacity curve and the demand curve be represented in 

response spectral ordinates.  

3.8.1 Capacity Spectrum, Demand Spectrum, 

Performance Point  

As graphically presented in Figure 3.6, the nonlinear static 

analysis procedure requires determination of three primary 

elements: capacity, demand and performance. The capacity 

spectrum can be obtained through the pushover analysis, 

which is generally produced based on the first mode 

response of the structure assuming that the fundamental 

mode of vibration is the predominant response of the 

structure. This pushover capacity curve approximates how a 

structure behaves beyond the elastic limit under seismic 

loadings.  

The demand spectrum curve is normally estimated by 

reducing the standard elastic 5% damped design spectrum 

by the spectral reduction method. The intersection of the 

pushover capacity and demand spectrum curves defines the 

“performance point” as shown in Figure 3.6. At the 

performance point, the resulting responses of the building 

should then be checked using certain acceptability criteria. 

The responses can be checked against acceptability limits 

on both global system levels (such as the lateral load 

stability and the inter-story drift) and local element levels 

(such as the element strength and the sectional plastic 

rotation). When the responses of a structure do not meet the 

targeted performance level, the structure needs to be resized 

and the design process repeated until a solution for the 

desired performance level is reached. In general, the 

determination of the satisfactory performance response that 

fulfill both the system level response and element level 

response requires a highly iterative trialand-error design 

procedure even with the aid of today’s engineering 

computer software.  

 

3.8.2  Conversion of Pushover curve to Capacity 

Spectrum Curve  
To convert a spectrum from the standard Sa (Spectra 

Acceleration) vs T (Period) format found in the building 

codes to ADRS format, it is necessary to determine the 

value of Sdi (Spectral Displacement) for each point on the 

curve, SaiTi This can be done with the equation:  

 

Sdi =   Saig  

 

Fig 3.6 - Nonlinear Static analysis procedure 

Standard demand response spectra contain a range of 

constant spectral acceleration and a second range of constant 

spectral velocity; Sv. Spectral acceleration, Sa and 

displacement at period Ti are given by:  

       

Saig =   Sv  

Sdi Sv  

The capacity spectrum can be developed from the pushover 

curve by a point by point conversion to the first mode 

spectral coordinates. Any point Vi (Base Shear), δi (Roof 

Displacement) on the capacity (pushover) curve is 

converted to the corresponding point Sai, Sdi on the 

capacity spectrum using the equations:  

   Sai  

Sdi  

Where α1 and PF1, are the modal mass coefficients and 

participation factors for the first natural mode of the 

structure respectively. Φ1roof is the roof level amplitude of 

the first mode.  

The modal participation factors and modal coefficient are 

calculated as:  

PF

 

ɑ  

Where w i is the weight at any level i.  

As displacement increase, the period of the structure 

lengthens. This is reflected directly in the capacity 

spectrum. Inelastic displacements increase damping and 

reduce demand. The Capacity Spectrum Method reduces 

the demand to find an intersection with the capacity 

spectrum, where the displacement is consistent with the 

implied damping. Figure 3.7 shows the conversion of 

Pushover curve to capacity spectrum curve. The damping 

that occurs when the structure is pushed into the inelastic 

range can be viewed as a combination of viscous and 

hysteretic damping. Hysteretic damping can be represented 

as equivalent viscous damping. Thus, the total effective 

damping can be estimated as:  

βeff = λβ0 + 0.05  

Where β0 is the hysteretic damping and 0.05 is the assumed 

5% viscous damping inherent in the structure. The λ-factor 
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(called κ-factor in ATC-40) is a modification factor to 

account for the extent to which the actual building 

hysteresis is well represented by the bilinear representation 

of the capacity spectrum (See Table  

3.7 & 3.8 and Figure 3.10).  

The term βo can be calculated using:  

 
Where ED is the energy dissipated by damping and ESO is 

the maximum strain energy. The physical significance is 

explained in Fig. 3.8.  

 

 
 

Figure 3.8 - Derivation of Energy dissipated by Damping 

 

Table 3.2 - Structural Behaviour Types  

Shaking 

Duration  

Essentially  new 

Building  

Average 

Existing 

Building  

Poor 

Existing 

Building  

Short  Type A  Type B  Type C  

Long  Type B  Type C  Type C  

 

Table 3.3 - Values for damping modification values, λ  

Structural Behaviour 

Type  

βo  Λ  

Type A  ≤16.25  1  

  
 ≥16.25   1.13 - 0.51  

Type B  ≤25  0.67  

  
 ≥25   0.845 - 

0.446  

Type C  Any 

Value  

0.33  

 

To account for the damping, the response spectrum is 

reduced by reduction factors SRA and SRV  which are given 

by:  

SRA  

SRv  

Both SRA and SRV must be greater than or equal to 

allowable values. The elastic response spectrum (5% 

damped) is thus reduced to a response spectrum with 

damping values greater than 5% critically damped (See 

Figure 3.9).  

3.8.2.1 Determination of Performance Point  

There are three procedures described in ATC-40 to find the 

performance point. The most transparent and most 

convenient method for programming is  

Procedure A, which uses a set of equations described in 

ATC-40.  

Procedure B is also an iterative method to find the 

performance point, which uses the assumption that the yield 

point and the post yield slope of the bilinear representation, 

remains constant. This is adequate for most cases; however, 

in some cases this assumption may not be valid.  

Procedure C is graphical method that is convenient for hand 

as well as software analysis. SAP2000 uses this method for 

the determination of performance point. To find the 

performance point using Procedure C the following steps 

are used:   

First of all, the single demand spectrum (variable damping) 

curve is constructed by doing the following for each point 

on the Pushover Curve:  

1. Draw a radial line through a point on the Pushover 

curve. This is a line of constant 

period.                                                                       

  

2. Calculate the damping associated with the point on 

the curve, based on the area under the curve upto 

that point.  

3. Construct the demand spectrum, plotting it for the 

same damping level as associated with the point on the 

pushover curve.  

4. The intersection point for the radial line and 

associated demand spectrum represents a point on the Single 

Demand Spectrum (Variable Damping Curve).  

5. A number of arbitrary points are taken on the 

Pushover curve and such points are obtained.   

6. A curve is then drawn by joining through these 

points. The intersection of this curve with the original 

pushover curve gives the Performance Point of the Structure 

as shown in fig. 3.10.  

3.9  Important Terms  

1.  Displacement Ductility  

The ability of a structure or member to undergo inelastic 

deformations beyond the initial yield deformation with no 

decrease in the load resistance.  

 

 

μ =  

Figure 3.10 Capacity Spectrum Procedure C to 

Determine Performance Point 2. Inelastic displacement 

demand  
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Expressed in terms of Inelastic Displacement demand Ratio 

(IDDR). IDDR represents the ratio of inelastic displacement 

demand over the ultimate inelastic displacement capacity.   

IDDR 

 

 
Figure 3.11 - Ductility and IDDR 

 

Where,  

Δy = yield deformation  

Δp = displacement at PP  

Δm = = maximum displacement.  

 

(IDDR)  

3. Plastic Rotations  

The sequence of plastic hinge formation and state of hinge 

at various levels of building performance can be obtained 

from SAP output. This gives the information about the 

weakest member  

 
Figure 3.12 - Determination of Performance Point (FEMA)  

   

 

 

 

 

4. Response Reduction Factor: 

 
Allowable Limits: 
FEMA – 356 has specified allowable limits for IDR, Plastic 

rotations, and IDDR values.  

Table 3.4 - Inter-storey drift ratio (IDR)  

Structural 

System  
OP  IO  DC  LS  CP  

Masonry Shear 

wall system  
0.005  0.007  0.007  0.007  0.009  

Others  0.005  0.010  0.015  0.020  0.025  

 

Table 3.5 - Plastic rotations (radian)  

Structura

l System  

IO  LS  CP  

Beams  0.00

5  

0.0

2  

0.02

5  

Columns  0.00

5  

0.0

1  

0.02  

 

Table 3.6 - Inelastic displacement demand (IDDR)  

Performance Level  OP  IO  DC  LS  CP  

IDDR  0.0  0.2  0.4  0.6  0.8  

 

This limit helps as a guide lines for the validation of model 

results. The results within the limits given above should be 

accepted.   

4 -SAP2000 MODELLING AND ANALYSIS  

4.1 General  
The main objective of performance based seismic design of 

buildings is to avoid total catastrophic damage and to 

restrict the structural damages caused to the performance 

limit of the building. For this purpose Static pushover 

analysis is used to evaluate the real strength of the structure 

and it promises to be a useful and effective tool for 

performance based design. 4.2 Description of structure  

The building considered for analysis is a typical G + 11 

storey R.C. building. The plan area of building is 15 x 15 m 

with 3 m as height of each typical storey. It consists of 3 

bays of 5m each in X-direction and 3 bays of 5m each in Y-

direction.  
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Table 4.1 - Basic Parameters Considered For Analysis  

Sr. No.  Basic Parameters Considered  

1  Grade of Concrete  M20   

2  Grade of Steel   Fe415  

3  Floor to Floor Height  3m   

4  Plinth Height above GL   0.55m  

5  Depth of Foundation Below GL  0.65m  

6  Parapet Height  1.5m  

7  External Wall Thickness   0.23m  

8  Internal Wall Thickness   0.15m  

9  Live Load on Floor   3 KN/m²  

10  Live Load on Roof   1.5 KN/m²  

11  Floor Finishes   1 KN/m²  

12  Roof Treatment   1.5 KN/m²  

13  Density Of Concrete  25 KN/m³  

14  Density Of Masonry Wall  20 KN/m³  

 

The sectional properties of various elements obtained based 

on gravity analysis and used as initial sizes for further 

analysis are presented as below -  

 Table 4.2 - Initial Member Sizes Considered For Analysis  

Sr. 

No.  
Member Dimensions  

Sizes in 

mm  

A  Columns at  500 X 500  

B  Beams at each floor level   300 X 300   

C  Thickness of Slab at each floor 

level   

150  

The considered earthquake parameters used for analysis are 

as follows -  

Table 4.3 - Earthquake Parameters 

Considered For Analysis  

Sr. No.  Earthquake Parameters  

1  Soil Type  Hard  

2  Importance Factor  1  

3  Time Period  Program Calculated  

4  Seismic Zone  III  

5  Building Frame Type  SMRF  

6  Seismic Zone Factor  0.16  

The Required codes are -  

Table 4.4 - Codes Used For Analysis  

Sr. 

No.  
Codes Used   

 

1  R.C.C. design   IS 456: 2000  

2  Earthquake resistant design of 

structures  

IS1893:2002  

 
Figure 4.1 – Plan 

 

 
Figure 4.2 – Elevation 

 

4.3 Step By Step Procedure  
A. Click the File Menu > New Model 

command or the New Model button. The form 

shown in Fig will display. Verify that the default 

units are set to KN, m, C.   

B. The New Model form allows for the quick 

generation of numerous model types using 

parametric generation techniques. However, in this 

project the model will started using only the grid 

generation. When laying out the grid, it is 
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important that geometry defined accurately 

represents the major geometrical aspects of the 

model so, it is advisable to spend time carefully 

planning the number and spacing of the grid lines. 

Select the Grid Only button and then form shown 

in Fig will display.  

C. The Quick Grid Lines form (Fig.4.4) is 

used to specify the grids and spacing in the X, Y 

and Z directions. Set the number of grids lines to 4 

in the X and Y direction, and to 13 in the Z 

directions. Type 5, 5, 3 into X, Y, Z directions 

spacing edit boxes respectively. The values 

specified in the First Grid Line Location area 

locate the origin of the grids lines; make sure that 

these values are all set to zero for this tutorial. 

Click the OK button to continue.  

 
Figure 4.4 - Quick Grid Line Form 

 

 
Figure 4.5 - SAP2000 Windows 

 

Step 2 - Begin a New Model  

Use the Define menu > Materials command to add, modify, 

or delete a material property definition. The material 

property definitions are then used in defining the structural 

objects (frame sections, cable sections, tendon sections, area 

sections, and solid properties.)  

 

 
Figure 4.6 - Define Material Form 

A. Click the Define menu > Materials command, the 

Define Material form (Fig.4.6) will display. Highlight a 

4000Psi in the Materials display list Then Click the 

Modify/Show Material button, the form shown in Fig. 8 will 

display.  

B. In Material Name and display color edit box, type 

M20 and in Material Type select concrete from drop down 

list.  

C. Set Weight per unit Volume as 25. Set Modulus of 

Elasticity to 22360679.774  

 
as per IS 456). Set Poisson's Ratio to 0.2. Set Specified 

Concrete Compressive Strength to 20000 and then click 

OK button.  

D. Highlight an A992fy50 in the Materials display list 

Then Click on Modify/Show Material button, the 

form shown in Fig.4.6 will display.  

E. In Material Name and display color edit 

box, type Fe415 and in Material Type select rebar 

from drop down list.  

F. Set Minimum yield stress (Fy), Minimum 

tensile stress (Fu), Expected yield stress, (Fye) and 

Expected tensile stress (Fue) to 415000, 498000, 

518750 and 622500. Click OK buttons on Material 

Property Data form and Add materials form to exit 

all forms.  

 

 
Figure 4.7 - Material Property Data Concrete 

Figure 4.8 - Material Property Data Rebar 
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Step 2 - Define Frame Section  
Defining a frame section makes the section available for 

assignment to selected objects. The Define menu > Frame 

Sections command can be used to (a) Import sections from 

predefined databases, (b) Define frame section properties on 

the basis of their dimensions, (c) review and modify section 

properties and (d) Delete section properties.  

 
Figure 4.9 - Frame Properties Form 

A. Click the Define Menu > Section 

Properties > Frame Sections command, which will 

display the frame properties form (Fig 4.9)  

B. Click the Add New Property button, 

which will display form shown in Fig.4.10.  

C. in Frame Section Property Type select 

Concrete from drop down list and click the 

rectangular button, which will display from shown 

in Fig 4.11  In Section Name Area, Type C-

500x500.  

 In Depth and Width edit box, Type 0.5 and 0.5 

respectively.  

 
Figure 4.10 - Add Frame Section Property 

 

 
Figure 4.11 - Rectangular Section 

D. Click the Concrete Reinforcement button, 

Reinforcement Data form (Fig 4.12) will appear.  

 In Rebar Material Area, Select Fe 415 from list as a 

Rebar Material of longitudinal Bars and 

confinement bars (Ties).  

 In Design Type Area, Select Column (P-M2-M3 

Design) Option.  

 In configuration of reinforcement area, select 

Rectangular.  

 In Longitudinal Bars - Rectangular Configuration 

Area, Type 0.05 in Cover to for confinement bars 

edit box.  

 In Confinement Bars Area, Select 10d from drop 

down list as confinement  

Bar Size; Type 0.2 in Longitudinal Spacing of 

Confinement Bars edit box and Type 2 in 

Number of Confinement Bars in 3-dir and 2-dir.  

 In set Check / Design Area, select Reinforcement 

to be designed.  

 Click OK buttons on Reinforcement Data form and 

rectangular section form.   E. Click the Add New 

Property button, which will display from shown in 

Fig 4.10  

 
Figure 4.12 - Reinforcement Data Form for Column 

 

 
Figure 4.13 - Reinforcement Data Form for Beam 

F. Make sure that in Frame section Property Type, 

Concrete is selected and click the Rectangular 

button, which will display from shown in Fig 4.11.  

 In Section Name Area, Type B-300x300.  
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 In Depth and width edit box Type 0.3 and 0.3 

respectively.  

G. Click the Concrete Reinforcement button, 

Reinforcement data form (Fig 4.12) will appear.  

 In Rebar Material Area, Select Fe415 from list as a 

rebar material of Longitudinal Bars and 

Confinement Bars.  

 In Design Type Area, Select Beam (M3 Design 

only) option, which will display reinforcement data 

form (Fig 4.13) for beam.  

 In Concrete Cover to Rebar Centre Area, Type 0.04 

top and bottom edit box.  

 Click the OK buttons on reinforcement data form, 

rectangular section form and frame properties 

form.   

Step 4 - Add Frame Objects  

In this step, Frame Objects with the associated column and 

beam sections list are drawn using the grids and snap- to 

options and generated using Edit menu Command   

A. Draw Frame Objects XZ. Made sure that 

the X-Z plane @ Y=0 view is active. Then select 

the DRAW FRAME or Cable option from left hand 

side tool bar which will give the properties of the 

objects which have to be draw (Fig 4.14).  

Confirm the properties given in earlier stage are updated 

.Here we will select first C- 500 X 500 property first.  

 
Figure 4.14 - Properties of Object Table of Column 

  

B. Select the Column Properties which was given in 

earlier step and draw the nodes  

C. Replicate the assigned columns in Y direction as 

well as Z directions using  

Replicate command of Edit Menu as shown in Fig. 4.16  

 

 

 

 
Figure 4.16 - Replication of assigned columns to Y and Z 

Directions  

D. Now again Select the Then select the DRAW 

FRAME or Cable option from left hand side tool 

bar which will give the properties of the objects 

which have to be draw (Fig 4.17). Now we will 

select property of beam by changing section to 

B300x300.  

 
Figure 4.17 - Properties of Object Table of Beam  

E. Select the Column Properties which was given in 

earlier step and draw the nodes of beams of FF as 

Shown in Fig 4.18.  

 
F. Replicate the assigned Beams in Y direction as 

well as Z directions using Replicate command of 

Edit Menu as shown in Figure 4.19. Similar 

procedure adopted for assigning beam in XY 

direction and then replicate it along Z direction and 

it will give the all nodes as per plan selected.   

G. After completion of assignment of frame objects, 

check the all objects are assigned appropriately. The Model 

will have now beams and columns allotted as per Fig.  

H. After assignment of objects column bases should 

be restrained. In this Step, supports for the frame 

are defined. Make sure X-Y plane @ Z=0 view is 

active, And that the program is in select mode.  

 Select the Support Nodes i.e. nodes at Z=0  
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Figure 4.21 - Joint Restraints Form 

 Click the Assign Menu > Joint > Restraints 

command to bring up the Joint Restraints form (Fig 

4.21).  

 Click the Fixed Support button to assign restraints 

in the Translation and rotation in 1, 2 and 3 

directions. Click Ok to accept changes.  

A. Now we have to assign the slab as an AREA object 

occurring in the model in the form of shell. Click the 

Define> Section properties > Area Sections. Area section 

form will arrive. Select the shell section type and click on 

add new section. The shell section form will arrive (Fig 

4.22). Fill the appropriate information and assumptions and 

click on OK.  

 
Figure 4.22 - Shell Section Data Form 

J. Now made sure that X-Y plane @ Y=3 view is 

active. Select Draw Rectangular Option from left 

hand side tool bar and assigned the slab area to the 

model. After assigning the all slabs @ Y=3, select 

them and replicate along Z direction. Then the 

model will have all its object (Fig. 4.23).  

 
Figure 4.23 - Object Filled Model 

 

 

Step 5 - Define Load Pattern   
The loads used in this problem consist of Dead, Dead Wall, 

Dead Slab, Dead FF (Floor finish), Dead RT (Roof 

treatment), Live and Live Roof loads acting in the gravity 

direction.  

A. Click the Define menu > Load Patterns 

command to bring up the Define Load Patterns 

form (Fig. 4.24). Note there is a single default load 

case defined, which is a Dead Load case with self-

weight (DEAD). Note that the self-weight 

multiplier is set to 1 for the default case. This 

indicates that this load pattern will Load Patterns 

and Load Cases exist, and they may be different. 

However, the program automatically creates a 

corresponding Load case when a load pattern is 

defined, and the load cases are available for review 

at the time the analysis is run. 

 
Figure 4.24 - Define Load Pattern Form 

B. Click in the edit Load Pattern Name column. Type 

the name of the new load pattern, DEAD Wall. 

Select a type of Load from the drop down list; in 

this case, select Super Dead. Make sure that the 

self-weight multiplier is set to zero. Click the Add 

New Load Pattern button to add the Dead Wall 

load to the load list.  C. Repeat item B, to add Dead 

Slab, Dead FF, Dead RT load cases.  

D. Type the name of the new load pattern, LIVE. 

Select LIVE, a Type of load from the drop-down 

list. Make sure that the Self Weight Multiplier is 

set to zero. Click the Add New Load Pattern button 

to add the Live load to the load list.  

E. Type the name of the new load pattern, 

LIVE ROOF. Select ROOF LIVE, a Type of load 

from the drop-down list. Make sure that the Self 

Weight Multiplier is set to zero. Click the Add 

New Load Pattern button to add the Live load to 

the load list.  

F. The Define Loads form should now 

appear as shown in Fig 4.25. Click the Ok button in 

that form to accept the newly defined static load 

cases.  

 
Figure 4.25 - Define Load Pattern 
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Step 5 - Assign Loads    
A. In this step, the Dead Load and Live Load will be 

applied to the model. The Dead floor finish, Live load first 

act on slab and then transferred to the beam by Trapezoidal- 

Triangle rule. So these Loads Assigned to Slabs. The Dead 

Wall Load Directly transferred to the beams so this load 

should be applied to beams only.  

B. First we will apply gravity loads to the slab i.e. 

Dead load, Dead FF and then will apply the Live loads. For 

application of dead load first select all the slabs by clicking 

on select menu > Properties > Area Section. Select the area 

section of slab. All Slabs automatically get selected.  

 
Figure 4.26 - Area Gravity Loads 

 

A. For assigning the dead load click on Assign menu 

> Area Loads > Gravity load. The software automatically 

calculate the dead load. Select Add to Existing load tab as 

shown in Fig.4.26 And click on OK.  

B. For assigning external gravity load like dead load 

select all slabs and click on Assign menu > Area Loads > 

Uniform shell to frame and assign the loads as per Fig.4.27 

and select Add to existing load tab and click on Ok. Similar 

procedure adopted for live load.  

 
Figure 4.27 - Area Uniform Loads to Frames Form 

 

C. Dead Load of wall directly acts upon the beams so 

this dead load should assigned to beams only. So, 

calculate the wall load the select all the beams and 

select Assign menu> Frame Loads > Distributed. 

Fill the frame distributed form as per Fig.4.28. 

And select add to existing load tab. and click on 

OK.  

 
Figure 4.28 Frame Distributed Loads 

 

Step 6 - Assign Rigid Diaphragm   
Make sure that X-Y Plane @ Z= 3 view is active and that 

the program is in the select mode.    

A. Select all nodes at Z=3, 6, 9 up to 36 level.  

B. Click the Assign Menu > Joint > Constraints 

command. This brings up the Assign / Define Constraint 

form (Fig 4.29).  

 
Figure 4.29 - Assign / Define Constraints Form 

 

C. In the Choose Constraint Type to Add Area, click 

the drop down list and select Diaphragm.  

 
Figure 4.30 - Assign / Define Plate Constraints Form 

 

D. Click the Add New Constraints button, which will 

display Diaphragm Constraint form (Fig 4.30).  

E. Type Floor Diaphragm in the Constraint name edit 

box.  

F. Verify that Z axis option is selected in the 

Constraint Axis area.  

G. Check assign a different diaphragm constraints to 

each different selected Z level box.  

H. Click the OK buttons on the Diaphragm Constraint 

and the Assign / Define Constraints forms to exist all forms.  

Step 7 Assign Earthquake Load Case   
Click the Define Menu > Load Cases command, which will 

display the Define load cases form.  

A. Click the Add New Load case Button, which will 

display Define Load case data form.( Fig 4.41)  



 

Smt. Thorat Sushma S. et al                            www.ijetst.in Page 3358 
 

IJETST- Vol.||02||Issue||11||Pages 3341-3363||November||ISSN 2348-9480 2015 

B. In Load Case Name Area, type EQ-X  

C. In Load Case Type Area, Select Earthquake from 

drop down list.  

D. In Modal Combination Area, Select CQC option.  

 
Figure 4.31 - Load Case Data- Response Spectrum Form 

E. In Load applied area,  

 In Load type area, select Accel from drop down 

list.  

 In Load Name Area, select U1 from drop down list.  

 In Function area select IS1893 II from drop down 

list.  

 In scale factor edit box type 0.3.  

 Click the Add button.  

C. Click OK button on the Load Case Data- Quake 

form to accept the EQ-X analysis case.  

D. Click the Add new load case button on the Define 

Load Case form.  

E. In Load Case Name Area, Type EQ-Y.  

F. Repeat Item D-E.  

G. Click OK button.  

Step 8 Define Mass Source   
A. Click the Define menu > Mass source command, which 

will display the Define mass source form ( Fig.4.32)  

`   
Figure 4.32 - Mass Source Data 

Form B. In Mass Definition Area, 

Select from loads option. 

C. In Define Mass Multiplier for loads area.  

 In Load area, select dead from drop down list.  

 Type 1 in Multiplier edit box.  

 Click the Add button to add mass source.  

 Repeat Item 1-3 for DEAD WALL, DEAD FF and 

DEAD RT load.  

 In Load area, Select LIVE from drop down list.  

 Type 0.25 (as live load ≤ 3 KN/m
2
) in Multiplier 

edit box.  

D. Click OK button on the Define Mass Source form 

to accept mass sources.  

E. Click the File menu > SAVE command or save 

button to save the model.  

Step 9 Run Analysis  
In this step, the Analysis will be run.  

A. Click the Analyze menu > Run Analysis command 

or the Run Analysis button, to bring up the set Load Cases 

to Run form ( Fig.4.33).  

 
Figure 4.33 - Set Analysis Cases to Run Form 

B. Click the Run now button on the set load cases to 

run form, which will display SAP Analysis 

Monitors. The program will create the analysis 

model from your object based SAP 2000 model. 

The information may be accessed at a later time by 

going to File Menu > Show Input/ Output Text 

Files command and selecting the file with .LOG 

extension.  

C. When the analysis is finished, the message 

“ANALYSIS COMPLETE" will display. Close the analysis 

window. The program automatically displays a deformed 

shape view of the model, and the model is locked. The 

model is locked when LOCK/ UNLOCK model button 

depressed. Locking the model prevents any changes to the 

model that would invalidate the analysis results.  

Step 10 Define Load Combinations  
A. Click the Define Menu > Combination command, 

which will display the Define Response Combinations form.  

B. Click the Add New Combo button, which will 

display the Response  

Combination Data form ( Fig 4.34)  

 Type 1.5 (DL+LL) in the Response Combination 

Name edit box.  

 Select Linear Add from the Combination type drop 

down list if it is not already selected.  

 
Figure 4.34 - Response Combination Data form 
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 Select dead in the Case Name from drop down list 

(if it is not already selected) and type 1.5 in the 

Scale Factor edit Box (If it is not already there) and 

click the Add button.  

 Select DEAD wall in the case Name from drop 

down list and click Add button.  

 Select DEAD FF in the Case Name from drop 

down list and click the Add button.  

 Select DEAD RT in the Case Name from drop 

down list and click the Add button.  

 Select Live in the Case Name from drop down list 

and click the Add button.  

 Click Ok button on Response Combination Data 

form to accept Combination.  

A. Similar procedure adopted to add all load 

combinations given below:-  

 1.2( DL+LL+EQX)  

 1.2(DL+LL-EQX)  

 1.2 (DL+LL+/- EQY)  

 1.5 (DL +/- EQX)  

 1.5(DL +/- EQY)  

 0.9DL+/-1.5 EQX  

 0.9DL+/- 1.5 EQY  

Step 11 - Push over Analysis  
In this step we carry out the Static nonlinear push over 

analysis.  

A. For carrying out we have to assign hinges to 

column and beams. Select all the beams with nodes first. 

Select Assign > Frame > Hinges will give the Frame Hinge 

Assignment Data Form. First select hinge property as Auto 

and keep relative distance 0 first and will get auto Hinge 

assignment data form. (fig 4.35) Select TABLE FORM 

FEMA 356 for auto hinge type and select Table 67 

(Concrete beams flexural) it will automatically select M3 

degree of freedom and click on OK.  

 
Figure 4.35 - Auto Hinge Assignment Data form for Beams  

B. After assigning one hinge to the beams assign other 

hinge property same as auto but change the relative 

distance to 1 and similar procedure as above should 

be adopted. Then we will get the Frame hinge 

assignment form as fig  

4.35. Click on Ok. The hinges will get assigned to the 

beams.  

C. Now for assigning the hinges to the column select 

all columns with nodes and similar procedure as 

per "hinges assigned to beams" is adopted. Here 

while selecting auto hinge type select FEMA 356 

and select table 6-8 as shown in fig 4.36. And click 

on OK.  

D. The all frame members are assigned with hinges 

should be checked. It will appear on the screen 

with hinge number and property. It will appear as 

Fig. 4.37.  

 
Figure 4.36 - Auto Hinge Assignment Data form for 

Columns 

 

 
Figure 4.37 - Frame with Hinges 

 

E. Now we have to set the model for push over 

analysis case. For setting out push over case first 

we have modify the DEAD load as a nonlinear. 

Select Define > Load pattern > Dead Load > 

Modify case. Load case data form as per Fig 4.38 

will appear change the analysis type from linear to 

nonlinear and click on OK.   

 
Figure 4.38 - Load Case Data- Nonlinear Static Form 

F. For adding push over case select Define menu > 

Load case pattern > Add new case. Write "PUSH" 

as Load Case Name and modify the form as per fig 

4.39.    



 

Smt. Thorat Sushma S. et al                            www.ijetst.in Page 3360 
 

IJETST- Vol.||02||Issue||11||Pages 3341-3363||November||ISSN 2348-9480 2015 

 
Figure 4.39 - Load Case Data for Push over Case 

 

G. While setting other parameters from fig 4.39, for 

load application select modify tab and change the 

load application control for static nonlinear 

analysis as Fig 4.40.  

`   

Figure 4.40 - Load Application Control for Nonlinear Static 

Analysis  

H. For setting of Results saved of other parameters 

click on Modify / Show tab and change the 

parameters as per fig 4.41. And click on OK 

button.  

 
Figure 4.41 - Results Saved for Nonlinear Static Load Cases  

J. After addition of Push Load case the model should 

be analyzed for the static push over analysis. Select 

Analyze > Run Analysis, "Set load cases to run 

analysis" window will obtain. Run only Dead load 

case and push over load case as per Fig 4.42. And 

click on the Run Now.  

 
Figure 4.42 - Set Load Cases to Run Form 

 

L. After Completion of analysis select Display > 

Show Static Pushover Curve and check the various 

parameters. To change the user parameters click on 

modify tab and change the user coefficients Ca and 

Cv as per fig 4.43. And click on Ok. The modified 

ATC 40 capacity curve is referred to get the 

results.   

 
Figure 4.43 - Parameters for FEMA 440 Equivalent 

Linearization 

 

4.4 Results  
We get results from the Static push over curve in terms of 

Ductility ratio, and performance point which helps to 

evaluate the Response reduction factor for both immediate 

occupancy level and life safety level.  

A. For Immediate Occupancy Level:-  

Formulation of Response reduction factor:-   

 Ductility factor:-   

Using equation for ductility factor, derived by Miranda and 

Bertero,  

 
          Where, Φ for medium soil is given by:-   

 
     For Immediate Occupancy Level, we have   
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= 2.210 sec. and µ = 1.148 (from Fig 4.44)  

Thus, Ø   = 1.042  

Rµ = {[(1.148-1) / 1.042] + 1}  

    = 1.270     

 
Figure 4.44 – Determination of Performance Point For IO  

 Over strength factor:-  

          Over strength factor (Rs) = V0 / VD  

          Where,   

 VO = Maximum Base Shear corresponding to performance 

point   

 VD = Design Base Shear Therefore,      

 Rs = (1072.855 / 520.596)   = 2.060  

          Therefore, the Over strength factor (Rs) of structure 

for IO level is 2.060.   

 Redundancy factor:-  

The redundancy factor depends upon the number 

of lines of vertical seismic framing.  

          Values to be considered are defined in ATC-19 as 

shown below:  

Table No.4.5 – Redundancy Factor Table from ATC-19 for 

IO  

Sr. 

No.  

Lines of Vertical 

Seismic Framing  

Drift redundancy 

Factor  

1  2  0.71  

2  3  0.86  

3  ≥ 4  1.00  

Thus, the Response reduction factor is given by:  

                                      R = Rs X Rµ X RR  

                                         

   = 2.060 X 1.270 X 

1.0                                   

              = 2.61   

B. For Life Safety:-  

Formulation of Response reduction factor:-   

 Ductility factor:-   

Using equation for ductility factor, derived by Miranda and 

Bertero,  

          Where, Φ for medium soil is given by: -  

          For Life Safety Level, we have   

T. = 2.592 sec. and µ = 

1.644   

Thus, Ø   = 0.660   

Rµ = {[(1.644-1)/ 0.660] + 1}  

    = 1.970            

Figure 4.45 – Determination of Performance Point 

for LS  Over strength factor:-  

        Over strength factor (Rs) = V0 / VD  

          Where,   

 VO = Maximum Base Shear corresponding to performance 

point   

 VD = Design Base Shear Therefore,      

 Rs = (1478.885/ 520.596)   = 2.840  

Therefore, the Over strength factor (Rs) of structure for LS 

level is 2.84.   

Redundancy factor:-  

The redundancy factor depends upon the number of lines of 

vertical seismic framing.  

Values to be considered are defined in ATC-19 as shown 

below:  

Table No.4.6 - Redundancy Factor Table 

from ATC-19 for LS  

Sr. 

No.  

Lines of Vertical 

Seismic Framing  

Drift redundancy 

Factor  

1  2  0.71  

2  3  0.86  

3  ≥ 4  1.00  

Thus, the Response reduction factor is given by:  

                                      R = Rs X Rµ X RR  

                                         

   = 2.840 X 1.970 X 

1.0                                   

               = 5.596   

C. Hinge Results  
Hinges are the points in the structure or frame which help us 

to analyze the structural behavior. Their rotation amount 

helps us verify the results. Figure 4.45 and 4.46 helps to get 

hinges behavior and their rotation. The color combination 

shown below the Fig 4.46 indicates the performance of 

hinges in given push case. 

 

 
Figure 4.4.6 – Hinge result 
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Figure 4.4.7 – Building Behavior in Push Over Case 

 

All above results are mentioned in below table – Table 4.7 – 

Results for IO and LS  

Parameter  

Immediate 

Occupancy  

Life Safety  

X 

Directi

on  

Y 

Directi

on  

X 

Directi

on  

Y 

Directi

on  

Base Shear  
1072.85

5 kN  

1072.85

5 kN  

1478.88

5 kN  

1478.88

5 kN  

Time 

Period  

2.210 

sec  

2.210 

sec.  

2.592 

sec.  

2.592 

sec.  

IDR  0.69  0.69  0.243  0.243  

IDR 

allowable  

1  1  0.25  0.25  

Ductility Ratio  1.148  1.148  1.644  1.644  

IDDR  0.1  0.2  0.55  0.55  

IDDR 

allowable  

0.2  0.2  0.6  0.6  

Plastic 

Rotation ()  

0.0041 

rad.  
0.0041 

rad  

0.00561 

rad.  

0.00561 

rad.  

allowable   0.005 

rad.  

0.005 

rad.  

0.02 

rad.  

0.02 

rad.  

Response 

Reduction  Fa

ctor (R)  

2.61  5.596  

 

The Above results are checked with guidelines given in 

FEMA 356 mentioned in this report in Table 3.4, Table 3.5, 

and Table 3.6, which shows that results are within limits & 

appropriate.  

5.  CONCLUSION AND FUTURE SCOPE  

5.1 General  
In the present study, the non-linear response of RCC frame 

using SAP2000 under the loading has been carried out with 

the intention to study the relative importance of several 

factors in the non-linear analysis of RC frames.  

5.2 Conclusions   
Following Conclusions are made from this study:-   

1. The frame behaved linearly elastic up to a base 

shear value of around 520 KN. At the value of 

base-shear 1072 KN, it depicted non-linearity in its 

behavior. Increase in deflection has been observed 

to be more with load increments at base-shear of 

1072 KN showing the elasto-plastic behavior.   

2. The joints of the structure have displayed rapid 

degradation and the inter storey deflections have 

increased rapidly in non- linear zone. Severe 

damages have occurred at joints at lower floors 

whereas moderate damages have been observed in 

the first and second floors. Minor damage has been 

observed at roof level.   

3. The frame has shown variety of failures like beam-

column joint failure, flexural failures and shear 

failures. Prominent failures are joint failures. 

Flexural failures have been seen in beams due to X-

directional loading.   

4. It has been observed that the top storey experienced 

major damages in this case opposite to the case of 

frame.   

5. Micro cracks have been observed to appear even 

when the frame is in its elastic zone. The cracks 

have been found increasing with the increase in 

deflections.  

5.3 Recommendations   
The literature review and analysis procedure utilized in this 

thesis has provided useful insight for future application of 

SAP2000 for analysis. It helps in comparing the results with 

experimental results data and study the difference between 

them. This study helped in understanding the basic approach 

of design and performance based seismic approach. 

Modeling the RCC frame in SAP2000 software gives good 

and efficient results which can be included in future 

research.  

4. Future Scope   

In the present study, frame used is symmetrical and square. 

The frame can be unsymmetrical and of irregular shapes. It 

has been studied under monotonic loads. The frame can be 

studied under cyclic-loading to monitor the variation in 

loaddeflection curves at given time history. The relationship 

between torsion moment  and deflection of building in 

seismic event can be derived.   

As this approach of seismic design is still in research, there 

are various parameters like allowable deflection of top floor, 

soil strata interaction are in current research and this 

approach can be modified according to it.  
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